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Grazie per avere acquistato un prodotto Sigma 
 
Per ottenere il massimo, e non causare danni o malfunzionamenti, leggere attentamente 
questo manuale, prima di usare il prodotto.  
 
Nota bene 
• Non riprodurre questo manuale tutto o in parte, senza permesso scritto. 
• I contenuti di questo manuale possono essere cambiati senza preavviso. 
• Abbiamo messo la massima attenzione nella stesura di questo manuale, tuttavia, se riscontrate 

errori, contattate il nostro rappresentante locale. Tuttavia decliniamo ogni responsabilità per 
eventuali errori.. 

• Le caratteristiche del prodotto possono essere cambiate senza preavviso. 
• SIGMA e i suoi rappresentanti declinano ogni responsabilità circa eventuali inconvenienti 

causati dall’uso di questo programma. 
 
Per evitare danni o malfunzionamenti leggere attentamente quanto segue, prima di usare il 
programma. 
 

 Attenzione ! Ignorare questo segnale può portare a seri inconvenienti e danni 

 
 Attenzione 

 
Non inserite il/i CD-ROM acclusi in un lettore Audio. Ascoltare questo CF-ROM con le cuffie 
può causare danni all’udito. Inserire l’accluso CD-ROM in un lettore per CD musicali può 
danneggiarne gli altoparlanti 
 
Le immagini realizzate con la vostra fotocamera  sono per uso personale e il loro uso non deve 
contravvenire le leggi del vostro Paese o leleggi internazionali. Inoltre, anche se le immagini sono 
di uso personale ricordate che possono esistere divieti di ripresa in occasione di manifestazioni, 
spettacoli, fiere ecc. Le leggi riguardanti il diritto d’autore o il diritto all’immagine non possono 
essere infrante. 
 
Marchi depositati 
 FOVEON è marchio registrato da Foveon, Inc. X3, e X3 è marchio depositato di Foveon Inc.. 
 Compact Flash è marchio registrato di SanDisk Corporation. 
 IBM PC/AT è marchio registrato di International Machines Corporation (IBM) negli Sati Uniti 
d'America 

 Microsoft and Windows sono marchi registrati o marchi proprietari di Microsoft Corporation 
negli Stati Uniti e negli altri Paesi 

 Adobe and Adobe Photoshop, sono marchi registrati di Adobe System Incorporated. 
 Microdrive è un marchio registrato di Hitachi Global Storage Technologies. 
 Tutte le ditte e i marchi nominati in questo manuale, sono registrati e di proprietà delle rispettive 
Ditte aventi diritto. 
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In questo capitolo si spiega… 
 
• Le principali prestazioni di SIGMA Photo 

Pro 
 
• Come consultare questo manuale 
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Cosa potete fare con SIGMA Photo Pro. Informazioni veloci 
Sotto potete vedere finestre e "palette" di SIGMA Photo Pro, programma per la fotocamera digitale SIGMA. 
Cliccare nella finestra o nella "palette" per informazioni più particolareggiate. 
 
 Finestra principale

• Scarica immagini dalla fotocamera al computer 
• Salvare gruppi di immagini in TIFF o JPEG 
• Contrassegnare, bloccare, ruotare e cancellare 

immagini dalla fotocamera o dal computer. 
• Stampa 
• Proiezione 
• Rinomina file 

 
 
 
 
  

Modalità e correzioni
• Correggere l’immagine, correggere 

l’esposizione,il contrasto,le ombre,le luci 
e la, saturazione 

• Regolare il colore 
• Caricare, salvare e cancellare I parametri 
• Vista dell’istogramma 
• Impostare le maschere di contrasto 
• Bilanciamento del bianco 

 

 

Finestra di 
visualizzazione
• Scegliere una regolazione 
• Salvare le immagini 
• Ingrandire I dettagli 
• Visualizzare le maschere 

di esposizione 
• Contrassegnare, bloccare, 

ruotare e cancellare le 
immagini 

• Passare da una immagine 
all’altra della finestra 
principale 

• Attivare i Controlli delle 
Correzioni ( Adjustment 
controls) 

• Stampa 
• Importa/esporta settaggi 

Finestra d’Informazioni 
sull’immagine
• Info sull’acquisizione 
• Info sul file 
• Info sul procedere del lavoro 
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Elementi della Finestra Principale 
Sotto trovate visualizzate le chiavi di accesso della Finestra Principale. Cliccate in ciascun link per 
visualizzare la sezione che è dettagliatamente descritta nel manuale. 
 
 

Cliccare sul pulsante Save Images As 
pag. 28 per lavorare e salvare immagini 
XF3 nei formati TIFF o JPEG 

Cliccare sul pulsante Review Images 
 pag. 21 per aprire la finestra di 
visualizzazione (Review Window) e 
lavorare le immagini 
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Usare Edit Button pag. 18 per ruotare, 
contrassegnare, bloccare o cancellare 
le immagini selezionate 

Cliccare su Info Button pag. 41 per 
aprire  la Finestra d’Informazioni 
sulle Immagini 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Usare Thumbnail Buttons pag. 16 per determinare 
stile e grandezza delle miniature 

 
 
 

Il  Computer Pane pag. 15 visualizza i drive e le 
cartelle del computer.Quando la SD14 è collegata 
l’icona comparirà in questa posizione. Cliccare su 
un drive o una cartella nel Computer Pane  per 
visualizzare immagini o cartelle 

Il Thumbnail Pane pag. 14 visualizza 
le immagini della fotocamera o 
della cartella che avete scelto 

 
 
 
 
 
 
Nota bene 
Se si collega al computer una SD9 o una SD10 non saranno rilevate. Usare un lettore di CF card. 
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Elementi della Finestra di Visualizzazione 
Sotto trovate visualizzate le chiavi di accesso della Finestra di Visualizzazione. Cliccate in ciascun link per 
visualizzare la sezione che è dettagliatamente descritta nel manuale. 

Premere Navigation Button pag.22 per andare avanti 
e indietro sulle immagini 

Manuale SIGMA Photo Pro  4 

Premere il pulsante Save Image As 
pag.29 per lavorare e salvare immagini 
X3F in formato TIFF or JPEG 

Usare Edit Buttons pag. 18  per  ruotare, 
contrassegnare,Cancellare l’immagini visualizzata 

Adjustment Modes pag.23  consente 
di visualizzare le immagini con 
differenti correzioni

Cliccare Info Button pag. 41 per aprire la 
Finestra delle Informazioni sull’Immagine 

Premere il pulsante 
Magnification pag.22 per 
diminuire o aumentare le 
dimensioni di 
visualizzazione 

Premere il pulsante Fit in pag.22 per 
resettare l’immagine nella finestra

Premere il pulsante X3F Button  pag.38 per 
cambiare I settaggi con quelli correnti Nel caso 
di file JPEG o TIFF saranno sovrascritti. 

Premere Adjustment Controls pag. 
32 per aprire Adjustment Controls 
Palette ( Finestra delle correzioni) 
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Il manuale fornisce le informazioni necessarie alla installazione e all'uso di SIGMA Photo Pro, il software 
dedicato alla fotocamera digitale SIGMA. 
 

Simboli ed espressioni convenzionali 
 

• I percorsi del menu sono indicati nel modo seguente 

Menu principale > Scelta della voce di menu 
 

• I tasti funzione sono indicati nel modo seguente 

Ctrl + lettera o simbolo 
 
“Ctrl” è abbreviazione che sta per  Control Key nella piattaforma Windows 

 

Navigazione nelle pagine digitali del manuale 
Per leggere le pagine del manuale SIGMA Photo Pro mentre lavorate con SIGMA Photo Pro, selezionare 
Help>SIGMA Photo Pro Help 
da qualsiasi finestra del menu, oppure digitare Ctrl + ? sulla tastiera 
 
Le seguenti opzioni, presenti nella versione PDF del manuale vi aiuteranno nella navigazione e nella 
ricerca veloce 
 
 
 
 
 Usare  Bookmarks 

per trovare gli 
argomenti principali 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Usare il tasto di Ricerca 
per trovare gli accessi 
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In questo capitolo imparerete a... 
 
• Installare SIGMA Photo Pro nel computer 
 
• Settare il monitor 
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Caratteristiche indispensabili di Windows 
Se usate la vostra fotocamera digitale con un PC, queste sono le caratteristiche minime necessarie per poter 
utilizzare il programma SIGMA Photo Pro 
  

• Windows 2000, Windows XP, Windows Vista* 
• Pentium III 750MHz 
• 256 MB RAM o superiore ( Raccomandata 512MB) 
• 1GB MB di hard disk 
• Display card a 16 o, meglio, a 24-bit 
• Monitor con risoluzione 800x600 pixel o maggiore. Raccomandato un monitor  da 1024x768 
• Porta USB  
• Lettore CD-ROM o DVD 

 
* Le caratteristiche dell’hardware sono diverse per Windows Vista 

 
 

Installare e disinstallare il programma 
Per installare SIGMA Photo Pro nel computer, inserite il CD del programma fornito assieme alla 
fotocamera SIGMA. Cliccate due volte sull'icona del CD che compare nella scrivania. Poi cliccare due 
volte su Set Up, se usate la piattaforma Windows. 
 

Una finestra di benvenuto comparirà nello schermo del 
computer. 
 
Una procedura d'aiuto vi condurrà, passo passo, a scegliere 
il linguaggio SIGMA Photo Pro, a creare le cartelle per le 
applicazioni e via di seguito. 
 
Nota: E' necessario chiudere altri eventuali programmi, 
prima di installare SIGMA Photo Pro, e poi riavviare il 
computer. 
 
Per disinstallare il programma, con piattaforma Windows, 
scegliere l'opzione Uninstall (Disinstalla) dal Menu di 

Avvio del programma Sigma Photo Pro, oppure Add/Remove Program tra le opzioni del Pannello di 
Controllo. 
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Verifica della luminosità, del gamma e dei colori del monitor 
Potete verificare il segnale d'uscita del monitor attraverso SIGMA Photo Pro scegliendo la voce 
Tools>Verification Monitor nella finestra principale. 
 
I grafici del box servono per controllare solamente gamma e luminosità. Usare i controlli indicati nel 
manuale d'uso del monitor per eseguire le varie regolazioni. 
 
Nota bene 
Quando si lavorano le immagini settare lo schermo del computer alla massima quantità di colori.Col 
tempo le caratteristiche del monitor decadono: controllarle periodicamente.Controllare e calibrare il 
monitor come indicato nel suo manuale d’istruzioni 
 

 Uso di un profilo monitor già impostato 
SIGMA Photo Pro accetta i profili monitor. Per 
maggiori informazioni sui profili medesimi 
consultare il libretto d'istruzioni del monitor 
oppure del sistema operativo. 
 

Scegliere la risoluzione più adatta alle 
dimensioni dello schermo 
SIGMA Photo Pro è progettato per lavorare con 
un monitor che abbia una risoluzione di 800x600, 
tuttavia l'area nella quale si vedono le immagini e 
le miniature non è ottimizzata per uno schermo di 
così piccole dimensioni. Una risoluzione di 
1024x768 o anche maggiore offre maggiori 
opportunità di lavorare con le immagini. Sigma 
Photo Pro ottimizza automaticamente l'area di 
visione quando, all'inizio della sessione di lavoro, 
si lancia il programma. A questo punto è possibile 
ridimensionare la finestra principale o quella di 
visualizzazione, o ridimensionare il pannello dei 
provini all'interno della finestra principale, 
oppure muovere le finestre in qualsiasi parte dello 
schermo. 
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In questo capitolo si insegna come… 
 
• collegare la fotocamera al computer 
 
• lanciare SIGMA Photo Pro 
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33     PP RR II MM AA   DD II   CC OO MM II NN CC II AA RR EE  

Manuale SIGMA Photo Pro  10 
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Con SIGMA Photo Pro è possibile collegare più di una fotocamera SD14 alla volta. 
 
Si può invece collegare solamente una SD9 o una SD10 alla volta. Scollegare eventuali altre 
fotocamere digitali per assicurare la migliore funzionalità al programma 
 

Collegare i cavetti 
Assicurarsi che l'alimentazione della fotocamera sia spenta, prima di collegare il cavetto USB oppure 
quello IEEE 1394 (FireWire™). Non collegare mai la fotocamera al computer con entrambe le porte, 
USB e IEEE 1394 (FireWire™) attive 
 

Accendere la fotocamera 
Accendere la fotocamera seguendo le istruzioni del manuale. SIGMA Photo Pro non rileva la presenza 
della fotocamera se non è stata accesa, dopo averla collegata al computer.. 
 
A questo punto siete pronti all'installazione del driver, ( p.7) se è la prima volta che collegate la 
fotocamera SD9 al computer 
 

Collegare la fotocamera 
Una volta accesa e collegata la fotocamera  il programma SIGMA Photo Pro è automaticamente 
lanciato. La finestra principale apparirà nel Pannello della Fotocamera contornato di blu.Tutte le 
immagini memorizzate nella CF card saranno automaticamente visualizzate nel Pannello delle 
Miniature.Un Pannello delle miniature vuoto indica  che la CF card era vuota. 
 
Nota bene 
SIGMA Photo Pro rileverà la SD14 come una memoria periferica. Le icone CF card e batteria non 
verranno visualizzate nel Pannello della Fotocamera 
 
 
33..22  LLaanncciiaarree  iill  pprrooggrraammmmaa  

Aprire e chiudere SIGMA Photo Pro 
 
E' possibile lanciare il programma SIGMA Photo Pro, senza che la 
fotocamera sia collegata, cliccando due volte sulla icona delle applicazioni. 
Comparirà la Finestra Principale e nel Pannello del Computer (Computer 
Pane) risulterà selezionata l'ultima cartella che avevate aperto. Tutte le 
immagini contenute in questa cartella, XF3, JPEG oppure TIFF saranno 
visualizzate.  Nessuna cartella risulterà selezionata se è la prima volta che 
aprite il programma SIGMA Photo Pro. 
 

Per uscire dall'applicazione, cliccare nel riquadro presente nella barra dei titoli della Finestra Principale 
(Main Window), oppure impostare File > Exit nel menu della finestra principale. 
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In questo capitolo s’impara a… 
 
 
• trasferire le immagini dalla fotocamera al computer 
 
• cancellare le immagini dalla CF card dalla quale le 

avete trasferite 
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Trasferire le immagini dalla fotocamera in una cartella del vostro computer assicura il salvataggio dei file 
X3F e JPEG per qualsiasi uso futuro. 
 
Nota: non è possibile effettuare il salvataggio su di un supporto solo leggibile, come un CD-ROM 
 

Collegare la SD14 al computer. 
Collegare la fotocamera SD14 al computer mediante il cavo USB in dotazione. Il computer la visualizzerà 
come una periferica. 
 

Trasferire le immagini dalla fotocamera al computer 
1.Trasferire le immagini in una cartella che già esiste 
 

1. Doppio clic sul drive o sulla cartella per scegliere i file dal Pannello del Computer, situato sulla 
sinistra della Finestra Principale.  

2. La cartella sarà visualizzata nel drive o nella cartella prescelta. A questo punto scegliere la cartella 
o la sottocartella da cui volete trasferire le immagini. 

Se si desidera creare una nuova cartella, cliccare col tasto destro del mouse e scegliere dal menu una nuova 
cartella.  

 
2. Aprire una cartella SIGMA ( da una cartella DCIM della fotocamera) e scegliere i file da 

trasferire. 
 
1. Doppio clic sul drive o sulla cartella per scegliere i file dal Pannello del Computer, situato sulla 

sinistra della Finestra Principale. 
2. Cliccare sulla cartella DCIM  
3. Cliccare nella cartella SIGMA creata nella cartella DCIM  
4. Scegliere nella finestra delle miniature (Thumbnali Pane) le immagini che si desiderano trasferire 

nel computer. Se si desiderano trasferire tutte le immagini, premere Ctrl + A  o cliccare “Select 
All” dal menu principale. 

 
3. Trasferire le immagini con copia-incolla (Drag & Copy or Copy &Paste). 
 

1. Posizionare la freccia del puntatore sull’immagine scelta e cliccare sul pulsante sinistro per spostarla 
nella cartella desiderata. 

2. E’ possibile trasferire le immagini cliccando col pulsante destro sulla immagine desiderata. Scegliere 
“copy” dal menu cliccando col pulsante destro e copiare l’immagine nella cartella desiderata 
scegliendo “paste” cliccando nel menu di destra.  

 
E’ possibile trasferire le immagini dalla CF card della fotocamera al computer seguendo la procedura 
appena descritta 
 

Uso di un lettore di CF CARD per trasferire le immagini nel computer 
Se possedete un lettore di CF card che il computer visualizza come drive, SIGMA Photo Pro lo riconoscerà. 
Potrete così trasferire direttamente dalla CF card al computer le immagini. 
Trasferire le immagini dalla fotocamera in una cartella del vostro computer assicura il salvataggio dei file 
X3F e JPEG per qualsiasi uso futuro. 
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In questo capitolo s’impara a… 
 
• visualizzare, osservare, ordinare le immagini 
 
• scegliere e spostare le immagini 
 
• rinominare le immagini 
 
•  segnare, bloccare, ruotare le immagini 
 
• cancellare le immagini 
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55..11  PPaannoorraammiiccaa  ssuullllaa  FFiinneessttrraa  PPrriinncciippaallee  

Funzioni principali 
Dalla Finestra Principale si possono eseguire le seguenti operazioni: 

• Trasferire immagini dalla fotocamera al computer 
• Visualizzare immagini in forma di miniature 
• Lavorare e salvare immagini a gruppi 
• Copiare e inserire immagini in nuove cartelle 
• Ruotare, segnare o bloccare immagini 
• Rinominare o cancellare immagini 
• Entrare nella finestra delle informazioni sulle immagini 
• Aprire una immagine nella finestra di visualizzazione (Rewiev Window) 
• Stampa 
• Slide show 

 
Il pannello delle Miniature  (Thumbnail Pane) visualizza immagini prendendole direttamente dalla 
fotocamera quando è impostato Camera Pane (Pannello della Fotocamera), o da qualsiasi cartella 
selezionata, quando Computer Pane. Computer Pane è attivo quando è evidenziato in blu. 
 
La finestra principale è sempre aperta quando si lavora con SIGMA Photo Pro. Chiudendo questa finestra si 
esce dal programma e si chiudono anche tutte le altre finestre e "palette", eventualmente aperte 
 

 Link per informazioni più dettagliate 
Cliccare sui link indicati sotto per avere informazioni più dettagliate sugli elementi contenuti nella Finestra 
Principale. 
 

Lavorare e salvare immagini

Info 
sull’immagine

Cancella

Stampar
Slide Show

Ruotare, contrassegnare 
e bloccare immagini

Aprire la Finestra di 
Visualizzazione

Marcare, bloccare le immagini
 
 
 
 
 
 

Pannello delle 
miniature

Finestra principale 

Pannello del computer Cambiare l’aspetto delle miniature
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Cambiare le dimensioni della finestra principale 
Usare i pulsanti nella barra del titolo per aumentare, ridurre o ritornare alle dimensioni della Finestra 
Principale. Potete trascinare la tavoletta nell'angolo in basso a destra per variare a volontà le dimensioni 
della finestra principale. 
 

Cambiare le dimensioni del pannello delle miniature 
Per cambiare le dimensioni relative del Pannello di Navigazione (Navigation 
Pane) e di quello delle Miniature (Thumbnali Pane) cliccare e trascinare la 
barretta di selezione esistente tra i due pannelli. SIGMA Photo Pro riproporrà 
questa dimensione alla prossima riapertura del programma. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Spostare il margine grigio da destra o sinistra 
per cambiare le dimensioni dei Pannelli delle 
Miniature e di Navigazione 
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55..22  VViissuuaalliizzzzaarree  llee  iimmmmaaggiinnii  nneellllaa  ffiinneessttrraa  pprriinncciippaallee  
 
 
 
 

Vedere le immagini memorizzate nel computer 
Cliccare nel pannello del computer per fare apparire l'ultima cartella 
visualizzata, nella sessione di lavoro precedente. La testata del Pannello del 
Computer (Computer Pane)risulterà evidenziata in blu e le immagini 
presenti nella cartella saranno visualizzate nel pannello delle miniature 
 
 
Quando l'ultima cartella visualizzata è stata cancellata, il pannello del 
computer risulterà evidenziato, ma non verrà selezionata alcuna cartella. 
 
Cliccare sulla cartella o sul drive per selezionarlo. Una barra blu e l'icona di 
cartella aperta indicheranno la cartella selezionata. 
 
Cliccare due volte sulla cartella per aprirla e visualizzare le sub-cartelle 
Se nel pannello delle miniature non compare alcuna immagine, significa 
che nella fotocamera non esistono immagini X3F o JPEG memorizzate, e 
neppure immagini TIFF, JPEG o X3F sono presenti nella cartella 
selezionata 
 
Nota:Per non incorrere in errori non si possono memorizzare più di 300 
file per ciascuna cartella. 

 



55     LL AA VV OO RR AA RR EE   LL EE   II MM MM AA GG II NN II         

Manuale SIGMA Photo Pro  16 

55..33  CCiinnqquuee  ddiiffffeerreennttii  mmooddii  ddii  vveeddeerree  llee  mmiinniiaattuurree  

 Cambiare stile e dimensioni delle miniature 
Cliccare sui pulsanti delle miniature alla base della Finestra Principale (Main Window) per vedere le 
miniature con o senza testo e a differenti grandezze 
 

Mini provini 
Cliccare il pulsante per selezionare View-Mini Thumbnail nella  Finestra Principale 

Miniature piccole 
Cliccare sul pulsante oppure selezionare View Small Thumbnails dal menu della Finestra Principale 

Miniature medie 
Cliccare sul pulsante oppure selezionare View Medium Thumbnails dal menu della Finestra Principale. 

Miniature grandi 
Cliccare sul pulsante oppure selezionare View LargeThumbnails dal menu della Finestra Principale 

Miniature piccole con dettagli 
Cliccare sul pulsante oppure selezionare View Thumbnails with Details dal menu della Finestra Principale. 

 
 
 
 
 
 

 Classificare e ordinare le miniature 
Le opzioni per classificare e ordinare le miniature si trovano sotto View, nel menu della finestra principale. 
Usare queste opzioni o i tasti corrispondenti per visualizzare gli specifici gruppi nel Pannello delle 
Miniature (Thumbnail Pane). 
 
 
 
 
 

Visualizzare solo file X3Fnel drive o nelle 
cartelle ( TIFF e JPEG non compaiono) 

Scegliere per filtrare l’immagine che 
avete contrassegnato o bloccato 

Ordinare le immagini nel Pannello delle 
Miniature a seconda della selezione 

Inverte l’ordine delle miniature o ripristina la 
visione del Pannello delle Miniature 
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55..44  RRiinnoommiinnaarree  llee  iimmmmaaggiinnii  

Rinominare le immagini 
Cliccare il tasto destro sulla miniatura e selezionare Rename dal menu 
 

Rinomina in Batch 
La finestra di dialogo “ Batch rename” consente di rinominare tutte le immagini di una cartella.Selezionare 
le immagini, cliccare su File nel Menu Principale e scegliere Batch Rename. Assegnare un nome,nella 
finestra Rename che individuerà tutte le foto della cartella della finestra Rename e scegliere un numero con 
cui partire ( Start whit). Se il nome del file è già esistente apparirà un messaggio di errore.
 

Rinominare le immagini fuori del programma Photo Pro 
l cambio  del formato del file (SDIM#####) o di un file X3F nella CF Card, rende il file illeggibile per la 
fotocamera. Trasferito nella memoria del computer il file può essere rinominato 
 
Nel PC se si rinomina un file al di fuori dell’applicazione, bisogna mantenere l’estensione .X3F se si vuole 
che il programma SIGMA Photo Pro lo riconosca come originale. I file elaborati avranno estensioni .TIF 
o .JPG e anche queste debbono rimanere invariate.  
 
Nota bene: non cambiare l’estensione quando si rinomina un file. Se si cambia estensione il file non verrà 
più riconosciuto da Sigma Photo Pro. 
 
 
55..55  SScceegglliieerree  ee  ssppoossttaarree  iimmmmaaggiinnii  

Scegliere una sola  immagine 
Per scegliere l'immagine cliccare una volta sulla sua miniatura. Cliccando due volte la si fa apparire nella 
Finestra di Visualizzazione (Review Window) Le immagini scelte sono evidenziate in giallo. 
 

Scegliere più di una immagine 
Usare le seguenti combinazioni quando si desidera selezionare o deselezionare una miniatura: 
 
• Shif t+ clic sulla miniatura  per selezionare una immagine contigua 
• Ctrl/ + clic per selezionare una immagine non contigua 
• Ctrl/ A per scegliere tutte le miniature 
• Cliccare in uno spazio vuoto oppure Ctrl + D per deselezionare tutte le miniature 
• Ctrl/ + Shift + I per invertire il senso della selezione delle miniature 

 
 
Questo menu, presente nella Finestra Principale, e i comandi di 
tastiera consentono entrambi di selezionare, deselezionare le 
miniature : 
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55..66  CCoonnttrraasssseeggnnaarree,,  BBllooccccaarree,,  RRuuoottaarree  iimmmmaaggiinnii  nneellllee  FFiinneessttrree  PPrriinncciippaallii  ee  
ddii  VViissuuaalliizzzzaazziioonnee

 

  

Ruotare immagini 
Usare i pulsanti di rotazione Rotate o ruotare CW/CCW dal menu Edit per riflettere 
orizzontalmente o verticalmente le miniature. Se si ruotano le immagini nella memoria 
delle fotocamera, esse manterranno tale aspetto anche se trasferite nella memoria del 
computer 

 
• Cliccare sul pulsante di rotazione sinistro per riflettere l'immagine orizzontalmente a sinistra 
• Cliccare sul pulsante di rotazione destro, per riflettere l'immagine orizzontalmente a sinistra 
• Saranno riflesse, a destra o a sinistra, solamente le immagini X3F, JPEG e TIFF. 
 

Contrassegnare e togliere il contrassegno alle immagini 
Contrassegnate le immagini che desiderate spostare, copiare, o lavorare. Le immagini segnate 
nella memoria della fotocamera rimarranno tali anche dopo il trasferimento al computer 
 

• Scegliere una o più immagini e cliccare sul pulsante di contrassegno (Mark), oppure scegliere Mark dal 
menu Edit 

• Scegliere una o più immagini già contrassegnate e cliccare sul pulsante di contrassegno (Mark) per 
togliere il contrassegno, oppure scegliere Umnark dal menu Edit 

• Se in un gruppo ci sono immagini contrassegnate e immagini non contrassegnate, tutte le immagini 
risulteranno contrassegnate 

• Se tutte le immagini del gruppo sono contrassegnate, cliccando sul pulsante Mark, tutte le immagini 
torneranno senza contrassegno 

• Solamente le immagini X3F possono essere contrassegnate. 
 

Bloccare e sbloccare le immagini 
Bloccare le immagini per evitare la loro cancellazione accidentale. Le immagini bloccate nella 
fotocamera continueranno ad esserlo anche dopo il trasferimento nel computer. 
 

• Scegliere una o più immagini e cliccare sul pulsante Lock (Blocca), per bloccarle oppure scegliere 
Lock dal menu Edit 

• Scegliere una o più immagini bloccate e cliccare su Lock per sbloccarle, oppure scegliere Unlock dal 
menu Edit 

• Se in un gruppo si trovano immagini bloccate e no, tutte vengono considerate bloccate 
• Se tutte le immagini selezionate risultano bloccate, cliccando sul pulsante Lock tutte le immagini 

verranno sbloccate 
• Possono essere bloccate tutte le immagini JPEG, TIFF e X3F. 
 
Nota: le memorie di sola lettura come i CD-ROM non permettono la procedura descritta sopra 
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55..77  CCaanncceellllaarree  llee  iimmmmaaggiinnii  ddaallllee  ffiinneessttrree  PPrriinncciippaallee  ee  ddii  VViissuuaalliizzzzaazziioonnee  

Cancellare immagini 

 
• Scegliere le immagini e cliccare sul pulsante Delete o battere il tasto delete sulla tastiera, oppure 

scegliere Delete dal menu Edit 
• La finestra di dialogo vi guiderà nelle operazioni di cancellazione 
• Le immagini bloccate debbono essere sbloccate prima di venire cancellate 
• Si possono cancellare immagini JPEG, TIFF e X3F 
• Immagini involontariamente cancellate possono essere recuperate dal cestino 
 
Nota: le memorie di sola lettura, come i CD-ROM non permettono la procedura descritta sopra 
 
 
55..88  SSttaammppaarree  iimmmmaaggiinnii  ddaallaa  FFiinneessttrraa  pprriinncciippaallee  oo  ddaa  qquueellllaa  ddii  
vviissuuaalliizzzzaazziioonnee  

Stampare immagini 
Cliccare sul pulsante Print button o scegliere dal menu File>Print.  Per maggiori informazioni 
consultare il capitolo 10.1. 
 
 

 
55..99  DDiiaapprrooiieezziioonnee  ((  SSlliiddeesshhooww))  nneellllaa  ffiinneessttrraa  pprriinncciippaallee  

Diaproiezione nella finestra principale 
Cliccare sul pulsante Slideshow o scegliere dal menu File>Slideshow. Per maggiori informazioni 
leggere il capitolo 10.2. 
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IInn  qquueessttoo  ccaappiittoolloo  ssii  ssppiieeggaa......  
 
• come aprire la finestra di visualizzazione 
 
• come vedere immagini differenti nella finestra di visualizzazione 
 
• come osservare i particolari mediante la funzione Magnification (lente 

d'ingrandimento) 
 
• come controllare luci e ombre mediante le maschere di contrasto 
 
• come usare i vari modi di correzione dell'immagine 
 
• come utilizzare  più finestre di visualizzazione 
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66..11  FFiinneessttrraa  ddii  vviissuuaalliizzzzaazziioonnee  

Aprire la Finestra di Visualizzazione 
Potete far comparire la finestra di visualizzazione nello schermo del computer cliccando due volte la 
miniatura oppure cliccando sul pulsante Review Images, dopo avere scelto l'immagine nella Finestra 
Principale 
 

Funzioni principali 
usare la Finestra di Visualizzazione (Review Window) per....: 
 

• Vedere immagini singole a grande dimensione e alta risoluzione 
• Lavorare e salvare immagini singole 
• Rivedere le immagini lavorate prima di salvarle 
• Entrare nella funzione di elaborazione delle immagini per apportare le correzioni desiderate 
• Contrassegnare, bloccare, ruotare o cancellare immagini 
• Navigare tra le immagini della fotocamera o tra quelle della cartella desiderata 
• Entrare nella finestra delle informazioni relative alle immagini 

 

 Link per informazioni più approfondite 
Cliccare su di uno dei link seguenti per attivare le funzioni dalla Finestra di Visualizzazione. 
 

Lavorare e salvare immagini

Informazioni sulle immagini

Ruotare, bloccare e cancellare immagini

Cancellare

Vedere le immagini con differenti correzioni

Zoom avanti/indietro

Stampa

Vedere altre 
immagini

contrassegn
a e blocca 
l’immagine

Correzioni personalizzate

Finestra di 
Visualizzazione 
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66..22  NNaavviiggaarree  iinn  uunnaa  ccaarrtteellllaa  ggrraazziiee  aallllaa  FFiinneessttrraa  ddii  VViissuuaalliizzzzaazziioonnee  

Scegliere quale immagine vedere nella Finestra di Visualizzazione 
Quando si apre la finestra di visualizzazione nello schermo compare la prima miniatura selezionata.  Un 
doppio clic su ciascuna miniatura oppure la selezione di una miniatura e conseguente clic sul pulsante di 
Visione Immagini (Review Images), sostituirà, nello schermo, l’immagine corrente. 
 

Usare il pulsante di navigazione (Navigation Button) per scegliere le immagini 
Cliccare sul pulsante di navigazione (Navigation) della Finestra di 
Visualizzazione (oppure sui tasti con le frecce della tastiera del vostro 
computer) per passare da una miniatura all'altra, tra quelle visualizzate 
nella finestra principale. E' anche possibile passare da un’immagine 

all'altra mediante le voci View>Next image oppure Previous Image, del menu della Finestra di 
Visualizzazione. 
 
Quando il pulsante Previous diventa grigio siete alla prima immagine della cartella. Quando diventa 
grigio il pulsante successivo (Next) siete sull'ultima immagine contenuta nella cartella. 
 
Quando passate da una cartella all'altra della Finestra Principale, entrambi i pulsanti di navigazione 
(Navigation) risultano disabilitati finché non sceglierete un’immagine da una nuova cartella. 
 

 Scegliere una specifica immagine dal Menu Principale 
Se desiderate vedere nella Finestra Principale, una volta che abbiate 
anche aperto la Finestra di Visualizzazione (Review Window)  una 
immagine particolare cliccate due volte sulla relativa miniatura che 
compare nella Finestra Principale. L'immagine presente nella Finestra 
Principale sarà rimpiazzata da quella nuova. 
 
 
 
 
 
 

 
 
 
66..33  FFuunnzziioonnee  IInnggrraannddiimmeennttoo  

 Pulsante Fit 
Cliccare sul pulsante Fit per visualizzare la grandezza 
dell’imagine nella Finestra di Visualizzazione. 
 

Cambiare l’ingrandimento 
Nella Finestra di visualizzazione compare un tassello con un 
ingrandimento fino a 1600 volte.Per cambiare l’ingrandimento 
cliccare sui pulsanti + o – vicini al pulsante 

Magnification( Ingrandimento). L’ingrandimento minimo è del 6,7% (1/15). E’ possibile aumentare o 
diminuire l’ingrandimento usando i tasti + o – della tastiera del computer. 
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66..44  VVeeddeerree  llee  iimmmmaaggiinnii  ccoonn  llaa  mmaasscchheerraa  ddii  ssoovvrraa//ssoottttooeessppoossiizziioonnee  ((HHiigghhlliigghhtt  aanndd  SShhaaddooww  
WWaarrnniinnggss))    

Usare la maschera per analizzare le luci e le ombre 
Il rosso indica le aree che superano i valori impostati nel Pannello di Controllo (Adjustment Controls 
Palette) dell'istogramma; il blu indica le aree scure al di sotto dei valori impostati nell’Adjustment Controls 
Palette (Pannello di Controllo). Per maggiori informazioni sulla maschera di contrasto vedere Paragrafo 
8.4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
66..55  UUssoo  ddeeii  sseettttaaggggii  ((AAddjjuussttmmeenntt  MMooddee  SSeettttiinngg))  
Usare il cursore Adjustment Mode per controllare se le immagini X3F sono state lavorate. 
 

La spia nell'angolo in alto a destra della Finestra di Visualizzazione 
risulterà in movimento mentre l'immagine viene lavorata. Quando il 
movimento cessa lo schermo si aggiorna sulla risoluzione più alta 

consentita dalla regolazione in corso. 
 
Per impostare una modalità differente, spostare il pallino blu su di un'altra modalità, oppure cliccare 
direttamente sopra 
 

Le immagini sono visualizzate se sono file X3F 

Modalità X3F: visualizzare le immagini senza alcuna correzione 
Con la modalità X3F l'immagine è visualizzata così come è stata 
ripresa dalla fotocamera SIGMA, senza alcuna correzione di 
esposizione, luminosità, contrasto o colore. 
Potete sempre cambiare i settaggi XF3 se desiderate cambiarli con 
quelli nuovi da voi scelti, semplicemente premendo il pulsante XF3 
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Auto Mode: rivedere le immagini con le correzioni automatiche 
Usando la modalità Auto i settaggi per ciascuna immagine sono 
regolati automaticamente. La modalità Auto rimane attiva finché non 
si imposta una modalità differente, o si procede al settaggio manuale 
mediante il pulsante Adjustmet Control. 
Per vedere quali parametri sono automaticamente regolati aprire 
Adjustmet Controls. La modalità Auto imposta automaticamente tali 

controllo per ogni immagine. 
Se desiderate intervenire sui parametri impostati automaticamente impostate i parametri desiderati nella 
palette Adjustment Control. In tal modo la modalità automatica è rimpiazzata da quella  di 
personalizzazione. 
usted automatically for each image displayed.  
 

Modalità automatica (Auto Mode): visualizzare le immagini corrette automaticamente 
Con la modalità Custom ciascuna immagine è visualizzata, nella 
Finestra di Visualizzazione secondo le correzioni disponibili nel 
menu di regolazione personalizzata (custom setting) o tra le 
correzioni non utilizzate 
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La modalità Custom rimane impostata finché non se ne sceglie 

un'altra, oppure si variano i vari parametri manualmente mediante il Controllo delle Correzioni Adjustment 
Controls. 
 
Dopo aver scelto un'altra modalità, i parametri dell’ultima regolazione personalizzata rimangono nel sotto 
menu. Si torna a questi parametri semplicemente ripristinando la modalità Custom. 
 

Regolazioni non salvate 
Finché la scritta " Current Unsaved Setting" compare nel menu, le regolazioni impostate sono quelle che 
compaiono in Adjustment Controls. 
 
La scritta " Current Unsaved Setting" compare nel menu ogni volta che si effettua una correzione mediante 
Adjustment Controls. Quando si muovono i controlli o i cursori, automaticamente si cambia la modalità 
Custom e la scritta "Current Unsaved Setting" comparirà nel sotto menu 
 

Potete salvare i settaggi cliccando il pulsante Save Setting nella sezione 
Adjustment Mode della Palette dei Settaggi. I settaggi salvati verrtanno 
applicati a tutti i successivi file X3F 
 

Potete anche salvare il settaggio originale di un file X3F sostituendolo con un settaggio 
impostato da voi. Per farlo cliccate il pulsante X3F della szione Adjustment Mode nella 
palette Adjustmente Control della finestra di visualizzazione E’ anche possibile salvare un 
nuovo settaggio X3F quando salvate una immagine attraverso mediante l’opzione Save dopo 
che avete creato un file TIFF oppure JPEG. Le opzioni rimangono memorizzate anche per 
eventuali, successivi, salvataggi 
 
Quando il pulsante X3F è disabilitato, tutti i valori dei settaggi sono memorizzati nel file,  e i 
settaggi del file X3F sono quelli che avete attribuito all’immagine 
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Nel caso le immagini visualizzate siano JPEG o TIFF 

Modalità File: rivedere le immagini senza correzioni 
Selezionato File ciascuna immagine sarà visualizzata con le 
correzioni di default 
Il settaggio corrente della modalità File rimarrà selezionato finché 
non scegliere un altro settaggio dal menu a comparsa o s’imposta un 
settaggio manualmente da Adjustment Control 
 

Modalità Auto: rivedere le immagini corrette automaticamente 
Selezionando Auto i settaggi sono corretti automaticamente per 
ciascuna immagine.  
La modalità Auto rimane impostata finché non se ne sceglierà 
un’altra oppure si imposterà Adjustment Control per la correzione 
manuale. Per vedere l’entità della correzione automatica aprire  

Adjustment Control. Auto Mode imposta tali settaggi automaticamente. Se desiderate variare i settaggi lo 
potete fare agendo con  Adjustment Control Pallet.  
Nota bene: la modalità Auto è sostituita da quella Custom, di personalizzazione. 
 

Modalità personalizzata ( Custom): rivedere le immagini con specifici settaggi 
Selezionando Custom ciascuna immagine sarà visualizzata secondo i 
parametri indicati nel menu a comparsa o secondo i parametri correnti 
non salvati. 
I settaggi correnti della modalità Custom rimangono selezionati 
finché non si sceglie un altro settaggio dal menu a comparsa, o si fa 

un settaggio manuale mediante il Controllo del Settaggio ( Adjustment Control) 
Dopo ave selezionato un’altra modalità, l’ultimo settaggio personalizzato rimane nel menu a comparsa. Si 
può tornare a questi settaggi selezionando nuovamente Custom. 
 
Nota: non è possibile applicare X3F Fill Light ai file JPEG o TIFF . 
 

Si possono aggiornare le immagini corrette mediante Auto o Custom Mode. Nel caso cliccare 
il pulsante File nella seszione Modalità di correzione ( Adjustment Mode) della finestra di 
visualizzazione o del Pannello  di Controllo 
 
Quando il file è selezionato ( e non sono state fatte correzioni) il pulsante File torna di colore 
grigio 
 
 
 

Nota: La funzione salva Settaggio non è applicabile a JPEG e TIFF. 
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66..66  FFiinneessttrree  ddii  vviissuuaalliizzzzaazziioonnee  mmuullttiippllaa  

Aprire le finestre di visualizzazione multipla 
Tenere aperta più di una Finestra di Visualizzazione consente di confrontare le immagini o impostare i 
relativi settaggi fianco a fianco. Per aprire una finestra di visualizzazione supplementare impostare, dal 
menu principale o dal menu della Finestra di Visualizzazione: File>Open New Review Window. 
 
Una volta aperta la finestra di visualizzazione multipla, un doppio clic su una qualsiasi miniatura presente 
nella Finestra Principale aprirà l'immagine nella Finestra di Visualizzazione. 
 
Nota : ciascuna finestra di visualizzazione occupa nel computer un certo spazio di memoria, perciò più 
sono le finestre aperte, più lento sarà il computer. Per ottimizzare le prestazioni del programma conviene 
chiudere le finestre di visualizzazione quando non si usano. 
 

Usare le finestre di visualizzazione multipla per confrontare tra loro le immagini 
Osservare immagini simili una a fianco dell'altra in singole finestre permette di confrontarne i dettagli, la 
composizione, l'espressione dei visi o la messa a fuoco, prima di decidere quale immagine lavorare e 
salvare 
 

Usare le finestre di visualizzazione multipla per confrontare le modalità di correzione 
Ogni Review Window ha un propria Modalità di Regolazione Adjustment Mode ogni immagine 
visualizzata nella stessa Finestra di Visualizzazione sarà lavorata secondo i parametri di quella specifica 
modalità. Vedere la stessa immagine duplicata una a fianco dell'altra permette di confrontare i settaggi, 
prima di decidere quale sia il migliore per l'immagine che si desidera lavorare. 
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In questo capitolo potete imparare … 
 
• come lavorare e salvare le immagini 
 
• come scegliere la risoluzione, il tipo di file, e lo spazio colore della 

immagine che state lavorando 
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77..11  FFiinneessttrraa  ddii  llaavvoorroo  pprriinncciippaallee  

Lavorare più immagini contemporaneamente 
Lavorare gruppi d'immagini in una sola volta è un buon modo per 
accelerare il lavoro con file X3F che non richiedano correzioni 
particolari. Non è possibile lavorare ciascun file, ma tutti i file saranno 

lavorati applicando loro i medesimi parametri di correzione. Tuttavia impostando il settaggio automatico, 
SIGMA Photo Pro ottimizzerà ciascuna immagine. 
 
Per lavorare un gruppo d'immagini : 

1) Scegliere la cartella che contiene le immagini X3F che si desiderano lavorare 
2) E' possibile lavorare sia tutte le immagini della cartella, sia quelle scelte, sia quelle contrassegnate 
3) Eventualmente scegliere o contrassegnare le miniature desiderate 
4) Cliccare su Save Images As Button 

 
Comparirà la seguente finestra di dialogo: 
 
 Sorgente 

Scegliere le immagini cliccando sul 
pannello 

 
 
 
 
  
 

Modalità di correzione: 
Scegliere  Adjustment Mode per 
lavorare le immagini

 
 
 
 

Usate questa opzione quando volete 
aggiornare i settaggi memorizzati nel 
file X3F 

 
 
 
 
 Possibilità di lavorazione:  

Scegliere  Risoluzione
 Spazio colore
 File in uscita

 
 
 
 

Destinazione: 
Cliccare Choose per scegliere dove 
archiviare . 

 
 
 
 
 
 
 

Cliccare OK per iniziare oppure 
Cancel per tornare al menu 
principale 

 
 
 
Nota: La metodologia precedente non può essere applicataa file JPEG e TIFF. 
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77..22  LLaavvoorraarree  ddaallllaa  FFiinneessttrraa  ddii  vviissuuaalliizzzzaazziioonnee  

Lavorare immagini singole 
Lavorare una immagine singola partendo dalla Finestra di Visualizzazione è la stessa cosa che lavorare 
partendo dalla Finestra Principale, con in aggiunta i seguenti vantaggi 
 

• La maggior parte delle lavorazioni sono attive mentre visualizzate una immagine, così che è 
possibile salvarla in memoria più velocemente 

• E' possibile rinominare il file così come sono stati salvati 
• E' possibile correggere i settaggi offerti dalla Tabella delle Correzioni (Adjustment Control 

Palette) 
• Potete osservare in modo più particolareggiato l'immagine prima di scegliere le correzioni da fare. 

 
Una volta scelta l'immagine da lavorare, premere il pulsante Save Image As... 
 
 

Comparirà la seguente finestra : 
 
 

Source:  
Qui sono memorizzati I dati 
originari e il nome del file  

 
 
 
 

Modalità di regolazione (X3F File 
only)

 
 
 Sceglire per cambiare I settaggi nel file 

X3F  
 
 

Modalità:  
Scegliere  Risoluzione
 Spazio colore
 File in uscita

 
 
 
 
 
 Destinazione: 

Cliccare Choose per scegliere la cartella 
di destinazione. E’ anche possibile 
rinominare il file. 

 
 
 
 
 
 
 
 
 

Cliccare OK per iniziare a salvare, o Cancel per tornare alla finestra 
principale 

 
 

Scegliere la destinazione 
Quando si salva una immagine bisogna scegliere dove salvarla. Generalmente le immagini sono salvate 
nell’ultima cartella usata per il salvataggio. Se si desidera cambiare destinazione cliccare il pulsante Select 
e scegliere quindi la nuova cartella. 
 
Nota: nel caso di file JPEG o TIFF, ripetuti salvataggi possono abbassare la qualità dell’immagine 
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77..33  OOppzziioonnii  ddii  llaavvoorroo    
Per applicare alle immagini i settaggi salvati usare il sottomenu e il suo pulsante rotondo. Impostando nella 
Finestra Principale "Save Image As " la finestra di dialogo sarà indipendente dai settaggi impostati nella 
finestra di dialogo Save Image As della Finestra di Visualizzazione relativa. 
 

Modalità di regolazione (X3F File 
only)
• X3F 
• Auto 
• Controllo della personalizzazione 
dati 

Nota: nel caso non siano visualizzati I 
file JPEG o TIFF 

 
 
 
 
 
 
 
 
 

Per cambiare I settaggi nel file X3F.  
 Risoluzione

• Uguale all’originale 
• Metà 
• Grandezza doppia 

Spazio colore
• sRGB 
• Apple RGB 
• Adone RGB 
• Color Match RGB 

Compressione file
• JPEG 
• 8 bit TIFF 
• 16 bit TIFF 

 
 
 
 
 
 
 
 
 
 
 
 
 

Risoluzione 
Il settaggio di default per quanto riguarda la risoluzione dell'immagine è il medesimo fornito al momento 
dello scatto dalla fotocamera (Alto, Medio, Basso). E' possibile impostare una risoluzione maggiore di una 
volta e mezza o anche due (aumenta il numero di pixel dell'immagine di una volta e mezza o due) sia nei 
file JPEG, sia nei TIFF  

Impostare le regolazioni 
Sono disponibili tre tipi di regolazione:X3F fornita dalla fotocamera o da SIGMA Photo Pro; Auto con 
regolazione impostate automaticamente da SIGMA Photo Pro; Custom, regolazioni impostate manualmente 
dal fotografo. Per maggiori informazioni sul funzionamento dei vari settaggi, vedi Sezione 6.5 Sono 
disponibili tre tipi di regolazione: Default fornita dalla fotocamera; Auto con regolazione impostate 
automaticamente da SIGMA Photo Pro; Custom, regolazioni impostate manualmente dal fotografo. Per 
maggiori informazioni sul funzionamento dei vari settaggi, vedi  Sezione  8.6.

Spazio Colore 
Impostare il corretto Spazio Colore richiesto a seconda di quanto richiesto da altri programmi, stampati e 
periferiche per ottenere colori reali. Se non esistono particolari richieste è consigliabile scegliere lo spazio 
colore standard di PC o Mac (sRGB o Apple RGB). Per particolari esigenze di controllo colore, potete 
scegliere lo spazio colore desiderato nel sotto menu. 

File prodotti 
SIGMA Photo Pro supporta JPEG, 8-bit TIFF, 16-bit TIFF 

Qualità 
E’ possibile cambiare la compressione dei file JPEG 
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IInn  qquueessttoo  ccaappiittoolloo  ssii  ssppiieeggaa  ccoommee…… 
 
• usare la tabella Adjustment Controls 
 
• come procedere a correzioni tonali 
 
• come procedere alla correzione dei colori 
 
• come usare l'istogramma 
 
• come impostare la maschera di sovra/sottoesposizione 
 
• Come variare il bilanciamento del bianco 
 
• come salvare le correzioni apportate 
 
• come cancellare le correzioni salvate 
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88..11  UUssaarree  llaa  ttaabbeellllaa  AAddjjuussttmmeenntt  CCoonnttrroollss  ppeerr  ccoorrrreeggggeerree  mmaannuuaallmmeennttee  llee  
iimmmmaaggiinnii  
La tabella Adjustment Controls permette di correggere manualmente i settaggi applicati alle immagini della 
Finestra di Visualizzazione. Quando si usano i cursori e le regolazioni della tabella. La finestra di 
Visualizzazione in uso entra automaticamente nella modalità Custom Mode (Personalizzazione, pag.. 24). 
Il sottomenu mostra la scritta "Current Unsaved Setting" la quale indica che le correzione è manuale. 
Finché non verrà scelta o salvata un'altra modalità operativa, le correzioni apportate nella tabella saranno 
applicate a ciascuna immagine della finestra di visualizzazione. Quando più Finestre di Visualizzazione 
sono aperte, il settaggio indicato si riferisce a quella che sta, nello schermo, davanti alle altre. 
 

Aprire e chiudere la tabella Adjustment Control 
Per aprire la tabella delle regolazioni (Adjustment Controls), cliccare sul 
pulsante Adjustment Controls, nella Finestra di Visualizzazione
  

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modalità di correzione pag. 38 
Serve per impostare la modalità di correzione e 
salvare tale specifica modalità 

Controllo dei toni pag. 33 
Da usare per correggere esposizione, ombre, alte 
luci, saturazione, incisione e X3 Fill Light ( solo con 
file X3F) 

Bilanciamento del bianco pag. 37 
Serve a cambiare il bilanciamento del bianco in un file X3F 
Nota: non è visualizzato con file JPEG o TIFF 

Controllo dei colori pag. 34 
Serve a rendere neutri e correggere i colori dell'immagine

Istogramma pag. 36 
Per valutare i valori di luminosità e assicurare la 
gamma di tonalità desiderata 

 
 

Ingrandire, rimpicciolire e chiudere la tabella 
Per ingrandire o rimpicciolire la tabella Adjustment Controls, cliccare nel pulsante grigio 
nell'angolo in alto a destra di una qualsiasi delle sezioni in cui è divisa la tabella: Adjustment 
Controls, Color Adjustment, Histogram, Adjustment Mode 

  
 Cliccare il quadratino sbarrato nell'angolo in alto a destra della barra di Adjustment Controls  per 
chiudere la tabella stessa. La chiusura delle finestre di visualizzazione comporta anche la 

chiusura della tabella. 
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88..22  CCoorrrreezziioonnee  ddeeii  ttoonnii  
Usare i cursori per correggere esposizione, contrasto, ombre, luci e saturazione, incisione, X3 Fill Light 
( solo per file X3F).  
 
Nella modalità Auto Mode, tutti i cursori, con la sola eccezione di Sharpness ( Incisione) sono attivi. Nel 
caso del cursore X3F Fill Light, si possono introdurre variazioni anche di piccola intensità.Come 
l’incisione ( Sharpness) il valore della correzione X3F Fill Light, di schiarimento delle ombre,  da 
impostare, dipende dalle preferenze di ciascun fotografo 
Nota: X3F Fill Light non può essere usato con file JPEG e TIFF. 

 

Esposizione 
Il cursore per la compensazione dell'esposizione modifica la 
luminosità generale dell'immagine, come se la luminosità 
della scena ripresa fosse diversa. Usarlo per correggere 
leggere sovra/sottoesposizioni. Ogni incremento di 0,1 operato 
mediante il cursore corrisponde a  0,1 di aumento o di 
diminuzione di f/stop.  L'ampiezza della correzione è di due 
stop in ogni direzione. Ciò corrisponde a circa  +/- due valori 
di diaframma /f 
 

Contrasto 
Il cursore del contrasto modifica la profondità dei neri e la 
luminosità dei bianchi mediante una sola regolazione. 
Aumenta il contrasto del bianco nei bianchi e quello dei neri 
nel nero. Diminuendo il contrasto si ingrigiscono sia i bianchi 
che i neri. L'ampiezza della correzione va da -2.0 a 2.0. 
 

Ombre 
Il cursore delle ombre modifica la profondità delle ombre. Un valore alto alleggerisce le ombre, un numero 
più basso le appesantisce. L'ampiezza della correzione va da -2.0 a 2.0 
 

Alte luci 
Il cursore delle alte luci modifica la brillantezza delle alte luci. Più il numero è alto, più le luci risultano 
brillanti, più il numero è basso, più le luci sono attenuate. L'ampiezza della correzione va da -2.0 a 2.0 
 

Saturazione 
Il cursore della saturazione modifica l'intensità dei colori presenti nell'immagine. Aumentare la saturazione 
significa avere colori più brillanti e profondi, diminuirla significa avere tinte pastello. L'ampiezza della 
correzione va da -2.0 a 2.0. Il valore minimo di saturazione di - 2.0 corrisponde a una immagine in 
Bianconero. 
 

Nitidezza 
Il cursore della nitidezza aumenta la nitidezza di ogni dettaglio dell’immagine. Più alto è il valore, 
maggiore sarà la nitidezza. Il valore di nitidezza va da –2 a +2 
 

X3, luce di riempimento ( solo con file X3F) 
Il cursore Fill Light schiarisce le ombre senza sovraesporre le zone chiare della fotografia. I valori entro cui 
opera il X3 Fill Lichter, vanno da-2.0 a 2.0 
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88..33  CCoorrrreeggggeerree  ii  ccoolloorrii  
Il Color Adjustment (Correzione Colore) si usa quando si vogliono cambiare tutti i colori dell'immagine. 
Ad esempio: se l'immagine ha una dominante giallastra, dovuta all’ illuminazione, aggiungendo cyan e 
magenta la si può correggere. 
 
I colori si  possono correggere manualmente mediante il Color Wheel (Ruota dei Colori), oppure si può 
usare il Color Adjustment Eyedropper per correggere automaticamente una dominante di colore, in un'area 
dell'immagine in cui la sintesi RGB dei colori non sia neutra. 
 
Per visualizzare il Cerchio Correzione Colore, visualizzare la tabella Adjustment Controls Palette e 
ingrandire la sezione titolata Color Adjustment 
 
 
 
 
 
 

Pulsante contagocce  
 
 
 
 
 
 
 
 
 
Cliccare  Reset per tornare ai valori di 
default 

 
 
 
 
 I valori di Cyan, Magenta e Giallo (Yellow), espressi in “CC” (valori di 

Correzione Colore) corrispondono a quelli rappresentati nel cerchio  
 
 

Usare il Cerchio dei Colori (Color Wheel) 
Cliccare e spostare il cerchio di puntamento in una qualsiasi parte del Cerchio. Man mano che ci si 
allontana dal centro del Cerchio, la tonalità del colore si farà più tenue. E' possibile spostarsi anche fuori 
dal cerchio, attenuando ancora i colori, anche se il cerchio di puntamento non è più visualizzato. 
 
Cliccare il pulsante Reset per tornare alla regolazione colore di default. 
 
 
 

 Aumenta I colori della sintesi 
sottrattiva  
(cyan, magenta, yellow) 
diminuisce I colori complementari 
(red, green, blue) 

Aumenta I colori della sintesi 
additiva (red, green, blue)  

Diminuisce I colori complementari 
(cyan, magenta, yellow) 
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Correggere manualmente le dominanti mediante il Cerchio dei Colori 
Per eliminare manualmente una dominante colorata, ad esempio una dominante gialla causata dalla 
illuminazione di un interno, usare la loupe (lente d'ingrandimento) della Finestra di Visualizzazione 
(Review  Window) per prendere a esempio una tonalità neutra. Con i valori RGB individuati dalla loupe, 
spostare il cerchio di puntamento nel Cerchio dei Colori fino a individuare i colori della sintesi CMY 
corrispondenti a quelli RGB. Una volta riconosciuto come neutro un colore, questo serve anche a bilanciare 
tutti gli altri  
 
I valori del cerchio di puntamento sono rappresentati dalla sintesi Cyan, Magenta e Giallo (Yellow) 
indicata sotto il Cerchio dei Colori in "CC" (valori filtro di correzione colore). la tabella sotto indica le 
corrispondenze tra rosso, verde e blu (Reed, Green, Blue) e Cyan, Magenta e Giallo (Yellow) 
 
Se pensate che l'immagine abbia una dominante, ma non trovate un il colore esatto di paragone, spostare i 
cerchio di puntamento nella direzione opposta a quella della dominante indesiderata da eliminare. Ad 
esempio, se l'immagine sembra troppo rossa, spostare il cerchio di puntamento verso il cyan, nella 
direzione opposta al rosso, rispetto al Cerchio Correzione Colori. 
 

Usare il Color Adjustment Eyedropper per correggere i colori 
 

Usare il contagocce (Color Adjustment Eyedropper) di SIGMA Photo Pro per avere 
immagini con toni di grigio senza dominanti. Scegliete una parte dell'immagine visualizzata 
nella Finestra di Visualizzazione che includa un colore conosciuto. Cliccare sul pulsante 
contagocce. Il cursore si trasforma in contagocce. 

 

 

Mettere il contagocce sopra il colore che si vuole rendere senza dominanti e 
cliccare. Il programma tiene conto dell'esempio ed esegue una correzione in 
modo da avere una tonalità di colore neutra 

Notate, nell'esempio come l'area presa a paragone sia di un 
blu debole. Una volta bilanciato, il valore di blu è 
aumentato da 147 a 198 e il grigio risulta neutro, come 
nella immagine originaria 

Prima 

Dopo la correzione  
 
Se non siete soddisfatti dei risultati ottenuti con il bilanciamento del grigio, cliccare sul pulsante Reset che 
trovate nella tabella in basso per tornare ai valori di default (senza correzione dei colori). E' anche possibile 
usare l'eyedropper come regolazione di base, da affinare muovendo il cerchio di puntamento nel Cerchio 
dei Colori. 
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88..44  UUssaarree  ll''iissttooggrraammmmaa  ee  llaa  mmaasscchheerraa  ddii  ccoonnttrraassttoo  

Leggere l'Istogramma 
Per visualizzare l'istogramma attivare la tabella Adjustment Controls Palette e aprire la finestra denominata 
Histogram 
 
 
 
 
 
 
 
 Attivare e disattivare 
le maschere di 
contrasto cliccando 
nel quadratino 

 
Cliccare le frecce per 
impostare i valori delle 
maschere di contrasto 

 
 
 
 
 
L'Istogramma visualizza i valori di luminosità dell'immagine. Abbiamo tre linee colorate di base, che 
indicano i valori di luminosità dei tre canali della sintesi RGB (Rosso, Verde e Blu). Sono gli stessi valori 
RGB che si possono leggere nell'angolo in basso a destra della Lente d'Ingrandimento della Finestra di 
Visualizzazione. 
 
Le ombre corrispondono alla parte sinistra del tracciato, le tonalità medie dal centro e le alte luci dalla parte 
destra. I valori possibili vanno da 0 (ombre chiuse) a 255 (alte luci) 
 

Attivare/disattivare e impostare i valori per la maschera di contrasto 
Per attivare/disattivare la maschera di contrasto cliccare il quadratino presente nella parte inferiore della 
finestra dell'istogramma. Nella maschera di contrasto è possibile impostare i valori desiderati, in modo da 
vedere se quelli dell'istogramma, relativi a ciascun canale, se ne discostano e di quanto.. Esempio: vi siete 
accorti che la vostra stampante o il vostro laboratorio non sono in grado di fornire dettagli nelle ombre i cui 
valori siano inferiori a 8, e che "bruciano" le alte luci superiori a valori di 240. Sapendolo potete impostare 
tali valori nella maschera di contrasto, in modo da accorgervi quando le luci e le ombre dell'immagine 
superano tali valori. Per impostarli cliccare sulle frecce che stanno sotto l'istogramma, finché non venga 
raggiunto il valore desiderato. 
 
Una volta impostati i valori, è 
possibile regolare manualmente i 
cursori della tabella Adjustment 
Controls, fino a riportare i valori 
dell'immagine a quelli impostati 
nella maschera di contrasto. 
. Questo uso della maschera di 
contrasto permette di ottimizzare 
la qualità tonale della stampa 
definitiva. 
 
「 Esempio di cosa si vede nella finestra di 
Visualizzazione applicando la Maschera di 
allerta per sotto/sovraesposizione 」 
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88..55  CCaammbbiiaarree  iill  BBiillaanncciiaammeennttoo  ddeell  BBiiaannccoo  

Cambiare il bilanciamento del bianco di un file X3F 
Durante la lavorazione dell'immagine possiamo variare il Bilanciamento del Bianco. Se si desidera 
cambiare il tipo di luce, in un’immagine particolare, è possibile cambiare il tipo di luce per livellare per 
ogni foto scattata dalle fotocaemre SIGMA.  
Per cambiare il Bilanciamento del Bianco, per prima cosa è necessario visualizzare un’immagine nella 
finestra di visualizzazione Review Window. Poi impostare Edit>White Balance dal menu della finestra di 
visualizzazione. Apparirà la seguente finestra di dialogo. 
 
 
 
 
 
 
 
Usare il sottomenu per impostare il Bilanciamento del Bianco ( White Bilance) che desiderate applicare a 
ciascuna immagine. 
 
Sunlight:  Per foto fatte in una giornata di sole 
Shade:  Per foto fatte all’ombra 
Overcast:  Per foto fatte in una giornata nuvolosa 
Incandescent:  Per foto fatte con illuminazione di lampade a incandescenza 
Fluorescent:  Per foto fatte con illuminazione di lampade fluorescenti 
Flash:  Per foto fatte con il flash Sigma EF 500 DG 
Auto:  In questa modalità il programma regola automaticamente la temperatura colore 
Monochrome:  Per avere immagini Monocromatiche, ad esempi in Bianco e Nero 
Original:  Non modifica il Bilanciamento del Bianco originale del file 
 
Per variare il bilanciamento del bianco in un gruppo di immagini bisogna prima sceglierle dalla finestra 
delle miniature, poi impostare nlla finestra principale Edit > White Balance (Nota: se non appare la finestra 
di dialogo significa che avete selezionato solo l’ultima immagine.) 
 
Per impostare un diverso bilanciamento del bianco, scegliere dal sotto m nu. Per maggiori informazioni sul 
bilanciamento del bianco consultare il manuale delle fotocamere SIGMA 

e 

 
Una volta impostato un nuovo valore di Bilanciamento del Bianco, il file X3F originale sarà modificato con 
i nuovi valori. Tuttavia nelle immagini visualizzate nel Menu Principale e nella Finestra di Visualizzazione 
non si produrrà alcun cambiamento.  
 
Ogni volta che s'impostano nuovi valori di Bilanciamento del Bianco, questi verranno impostati nel file 
X3F. Per vedere i nuovi risultati bisogna attendere che la lavorazione dell'immagine sia terminata 
 
 
Nota: lavorando l’immagine con la modalità “Monochrome” non si cancellano le informazioni colore. 
Perciò è possibile variare il Bilanciamento del Bianco (White Balance) dopo aver lavorato una immagine 
in  bianconero 
 
Nota: Non si possono usare Media, come CD-ROM, non sono abilitati alla azione precedente 
 



77     CC OO RR RR EE GG GG EE RR EE   II MM MM AA GG II NN II  

Manuale SIGMA Photo Pro  38 

88..66  SSaallvvaarree  ee  iimmppoossttaarree  ii  sseettttaaggggii  ppeerrssoonnaalliizzzzaattii  ((CCuussttoomm))  

Impostare i settaggi dalla finestra Adjustment Controls 
Per  vedere Adjustment Mode bisogna aprire nello schermo la finestra Adjustment Controls Palette e 
aprire la tabella chiamata Adjustment Mode. 
 
Le regolazioni della tabella Adjustment Mode, aperta dalla finestra Adjustment Control portano le 
medesime informazioni di Adjustment Mode che si trovano nella Finestra di Visualizzazione in funzione.  
vedi pag. 23 per altre informazioni 
 
 

Cliccare per aprire e chiudere il pannello 
Adjustment Control 

 
 
 
 

Cliccare il pulsante Save per salvare il 
settaggio in uso in  Adjustment Control 
Palette. Cliccare il pulsante Delete per 
togliere I settaggi indesiderati. 

 
 
 
 

Salvare i settaggi 
Per salvare i settaggi in corso nella tabella Adjustment Control Palette cliccare il pulsante Save Setting 
situato alla base della tabella Adjustment Mode Panel. Comparirà la finestra di dialogo Save Setting.  
 
Per salvare un nuovo settaggio, battere il nome nel campo delle denominazioni. Per aggiornare un settaggio, 
salvato in precedenza, cliccare sul nome del settaggio che desiderate aggiornare. Infine cliccare  
Save.  
Nel caso non salvasse, cliccare Cancel Button e chiudere la finestra di dialogo 
 

Cancellare i settaggi
Per cancellare i settaggi salvati, cliccare sul pulsante Delete Setting situato nella parte bassa della tabella 
Adjustment Mode Panel. Comparirà la finestra di dialogo Delete Setting.  
 
Cliccare sul nome del settaggio che si desidera cancellare e, infine, cliccare Delete 
 

Sostituire i settaggi X3F memorizzati 
Per sostituire i  settaggi originali X3F  ( quelli di default delle vostra fotocamera SIGMA) con i settaggi 
correnti cliccare il pulsante X3F. Una finestra di dialogo confermerà che desiderate cambiare i settaggi 
inclusi  nel file X3F. 
 
In qualsiasi momento potete rimpiazzare  i settaggi X3F orreznti con altri, a vostra scelta, cliccando il 
pulsante X3F. Questa possibilità consente di salvare settaggi molto particolari, su misura per ciascuna 
immagine 
 
Per tornare ai settaggi originari X3F, impostare Custom Mode ( Modalità Personalizzata) e scegliere Zero 
Adjust dalla finestra di dialogo. Una volta selezionato, cliccare ancora sul pulsante F per sostiuitr i settaggi 
correnti con quelli originari X3F, registrati dalla vostra fotocamera SIGMA 
 
Per applicare i vostri settaggi X3F, quando lavorate una sola immagine, impostate la modalità X3F nella 
finestra di visualizzazione, nella Adjustment Control Palette oppuredalla finestra di dialogo Save della 
finestra di visualizzazione 
 
Per applicare i vostri settaggi X3F a gruppi d’immagini, selezionare X3F Mode dalla finestra di dialogo 
Save della finestra principale
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In questo capitolo si spiega come… 
 
• trovare le informazioni sull'immagine nella finestra principale e in 

quella di visualizzazione 
 
• aprire la finestra d'informazioni sull'immagine (Image Info) per 

avere ulteriori informazioni 
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99..11  IInnffoorrmmaazziioonnii  ssuullll’’IImmmmaaggiinnee  

Informazioni sull’Immagine nella Finestra Principale e di Visualizzazione 
Se un’ immagine singola è selezionata nella Finestra di Visualizzazione, le informazion su di essa 
compaiono nella finestra delle miniature in un apposito campo.Quando più immagini vengono selezionate , 
il campo delle informazioni, nella finestra principale, rimane vuoto. 
  
Le informazioni comprendono : 

• Nome del file 
• Data e ora della ripresa 
• Apertura di diaframma, velocità dell’otturatore 
• ISO, risoluzione, lunghezza focale dell’obiettivo, modo di esposizione 
• Grandezza del file (MB) e Bilanciamento del Bianco-pixel 

 
Il medesimo campo d'informazioni sull'immagine appare nella Finestra di Visualizzazione . 

 
Oltre alle informazioni date dal testo, le singole immagini portano indicate, nel loro campo 
delle informazioni, se sono contrassegnate, se sono bloccate e se sono state trasferite. Se 

l'immagine selezionata è un TIFF o un JPEG lavorato con un programma diverso da SIGMA Photo Pro, le 
informazioni riguarderanno solamente il tipo di file e se è bloccata oppure no. 
 

 Informazioni sull'immagine nella tabella delle miniature (Thumbnail Pane) 

Le informazioni circa le immagini scelte compaiono nel campo riservato all’informazione esistente sotto la 
Tabella delle Miniature nella Finestra Principale. Nel campo troviamo indicate quante immagini sono state 
scelte e quanti MB totali occupano 
 

Informazioni sull'immagine nel Pannello del Computer (Computer Panel) 
Informazioni di questo tipo si trovano nel campo informativo, esistente sotto il 
Pannello Camera e il Pannello Computer. Vi si trova il numero delle immagini 
presenti nelle varie cartelle e il numero totale di MB occupati. 
 
 
 
 
 
 
 
 
 
 
 
 

Campo informativo
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99..22  EEnnttrraarree  nneellllaa  FFiinneessttrraa  ddeellllee  iinnffoorrmmaazziioonnii  ssuullll''iimmmmaaggiinnee  

 Pulsante per le informazioni sulle immagini 
E' possibile avere maggiori informazioni su ciascuna immagine o gruppi di immagini cliccando il pulsante 
Image Info nella Finestra Principale oppure in quella di Visualizzazione 
 

 Finestra per le Informazioni sull'Immagine 
La Finestra delle Informazioni informa sulle immagini 
scelte dalla Finestra Principale o da quella di 
Visualizzazione. Una delle Finestre d'Informazione 
sull'Immagine che trovate sotto, comparirà nello schermo, 
a seconda del numero delle immagini che avete scelto 
 
Per avere informazioni su più immagini, cliccare nella 
Finestra di Visualizzazione che contiene tale immagine, 
oppure nella relativa miniatura presente nella Finestra 
delle Miniature. La Finestra delle Informazioni 
sull'Immagine sarà aggiornata con le informazioni 
riguardanti la nuova immagine 
 
La finestra che riporta le informazioni sulle immagine 
rimane aperta nello schermo del computer nelle finestre 
Principale e di Visualizzazione finché non è chiusa, o 
finché non si esce dal programma. Per chiudere la 
Finestra di Visualizzazione, senza uscire da SIGMA 
Photo Pro, cliccare sul pulsante Close nella barra del 
titolo oppure sul pulsante Close, alla base della finestra. 

 
Per inserire un testo nella finestra delle informazioni sull'immagine, cliccare sul 
pulsante Copy to Clipboard. Poi battere il testo usando un qualsiasi programma 
di scrittura. Potete così usare la funzione "stampa", dello stesso programma, per 

riportare il testo che avete scritto. Se decidete di salvare tali file di testo nelle cartelle di SIGMA Photo Pro 
per potervi accedere più tardi, ricordate che non possono essere visualizzati mediante SIGMA Photo Pro, 
ma solamente dal programma usato per scriverli. 
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In questo capitolo trovate… 
 
• Come stampare le immagini 
 
• Come fare uno slide show 

 



11 00 SS tt aa mm pp aa   ee   ss ll ii dd ee   ss hh oo ww           

Manuale SIGMA Photo Pro  43 

1100..11  SSttaammppaarree  iimmmmaaggiinnii  ddaallllaa  FFiinneessttrraa  ddii  VViissuuaalliizzzzaazziioonnee  
Per stampare le immagini cliccare sul pulsante Print nella finestra principale o selezionare file-print 
 
 

Quando si procede nella stampa, apparirà la seguente finestra di dialogo. La finestra dei settaggi di stampa 
è nella parte sinistra di questa finestra di dialogo e la finestra di previsualizzazione della immagine è nella 
parte destra. 
 

 

Dimensioni della 
stampa 

Finestra di preview Finestra dei 
settaggi di 
stampa 

 

Finestra dei settaggi di stampa 
 

 

Settaggio della stampa: 
E’ possibile settare il layout, il numero di copie e 
altro 

Grandezza della stampa: 
E’ anche possibile settare quante immagini si 
vogliono stampare nello stesso foglio. Il preview è 
visualizzato sulla destra. 

Settaggio stampante: 
Per cambiare i settaggi della stampante cliccare il 
pulsante . La qualità della stampa, le sue dimensioni 
ecc saranno settate secondo le possibilità della 
stampante 

Modalità di correzione: 
E’ possibile selezionare le correzioni delle immagini 
che desiderate stampare da X3F, Auto oppure 
Custom ( Solo file X3F) 

Sorgente: 
Le immagini da stampare si possono scegliere tra 
Tutte le immagini, Immagini marcate, Immagini 
selezionate 
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Grandezza delle stampe 
E’ possibile scegliere il numero d’immagini da stampare su di un solo foglio. La situazione di stampa è 
indicata sulla destra. 
 
Esempio: Quando si stampa su formato A3 

8x10 (2)-A3 (297×420mm) 
5x7 (4)-A3 (297×420mm) 
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4x6 (4)-A3 (297×420mm) 
3x5 (9)-A3 (297×420mm) 
2x3 (25)-A3 (297×420mm) 
1.5x1.5 (54)-A3 (297×420mm) 
“ Inserisci nell’area di stampa” 

Dimensioni carta
Foto nello stesso foglio

Dimensioni stampa

 Per inserire l’immagine 
nell’area di stampa   

 
Nota: Si possono scegliere le seguenti dimensioni ( in pollici): 8x10, 5x7, 4x6, 3x5, 2x3 e 1.5x1.5. 
Nel menu a comparsa non compare la dimensione dell’immagine se questa eccede la grandezza del foglio 
di stampa. Se stampate con una dimensione maggiore di 8x10 pollici, impotsare Inserisci nell’area di 
stampa.  
 

Rotazione automatica 
Con l’opzione Auto Rotate le immagini saranno stampate nella grandezza massima compatibilmente con il 
layout definito prima della stampa. 
 

Auto Crop 
Selezionando Auto Crop ( Taglio automatico) l’immagine sarà rifilata sulla grandezza del foglio di carta da 
stampa. In questo caso apparirà lo strumento specifico muovendo il cursore sul preview dell’immagine. E’ 
anche possibile cambiare il layout. 
 

Numero di copie 
E’ anche possibile scegliere quante copie fare della stessa stampa. 
 
Cliccare sul pulsante Print dopo aver impostato i vari settagi. Se non desiderate stampare, cliccare il 
pulsante Cancel. 
 
Nota: 
quando si stampa dalla finestra di visualizzazione ( Review window, saranno stampate solamente 
le immagini visualizzate.. Nè è possibile impostare la modalità di correzione ( Adjustment, né la 
selezione dlloe immagini ( Select Images) 
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1100..22  SSlliiddee  sshhooww  nneellllaa  ffiinneessttrraa  pprriinncciippaallee  
Per effettuare lo slide show, cliccare il pulsante Slide Show nella finestra principale o impostare 
File-Slide Show dal menu. 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

Durata 
Impostate il tempo per ogni immagine dal 
menu. Può variare da 1 a 10 secondi 

Transizioni 
Scegliere la modalità di transizione tra una 
immagine e la successiva. Si può anche 
scegliere tra zoom, dissolvenza, rullo, 
diamante, scegliendo le varie opzioni dal menu.

Ripeti 
Se si vuole ripetere lo slide show impostare 
Loop 

Per iniziare lo Slide Show, cliccare il pulsante Play. Se non volete più, cliccate il pulsante Cancel. Per 
selezionare le immagini agire sulla barra spaziatrice della tastiera per ogni immagine che desiderate 
immettere. Battendo ESC durante lo slide show, questo terminerà. 
 

Visualizzazione dello slide show 
 

Zoom 
L’immagine successiva appare al centro dello schermo 
 
 
 
 
 
 
Dissolvenza 
L’immagine appare poco per volta dopo la precedente 
 
 
 
 
 
 
Rullo 
L’immagine si sposta da destra a fa spazio alla successiva 
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Volta pagina 
L’immagine successiva appare come si stesse voltando un foglio a 
partire da sinistra in alto 
 
 
 
 

 
 

Diamante 
L’immagine successiva appare dopo quella precedente in una finestra a 
diamante 
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